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1

INSTALLING DRIVERS FOR DS PRINTERS

The installation workflow will consist of three steps:

Prepare the printer and computer

Install the driver package

Install the printer drivers

PREPARING THE PRINTER AND COMPUTER

Check that the power for the DS40/DS80 printer is OFF. Have the USB cable ready, but DO NOT connect the printer to the 
computer with the USB cable at this point.

Note
In order to install the printer drivers you must be logged in to the computer with administrator 
privileges. 

Note
Installing the driver is the same for both the DS40 and DS80 printers. The following instructions 
are for the DS40, but if you are using a DS80, it will be the same (read DS40 as DS80).

INSTALLING THE DRIVER PACKAGE

1. Insert the Driver Installation CD into the disc drive.

2. Start Windows Explorer and double-click on the CD drive.

Note
If the AutoPlay function is on, select Open folder to view files – using Windows Explorer.
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Installing the Driver Package

3. Select the following folder from the Driver Installation CD.

DS40 = DS_Driver\DS40\English\7

DS80 = DS_Driver\DS80\English\7

Figure 1. Driver Package Folder

4. Double-click on the Driver Install.CMD file inside the folder. (Depending on your operating environment, the .CMD 
extension may not be displayed.)

Figure 2. Install File

5. The best Driver Package Installer for your operating system (32- or 64-bit) will automatically be selected.
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Installing the Driver Package

6. If the User Account Control dialog appears, click on Yes.

Figure 3. User Account Control

7. When the Welcome to the Device Driver Installation Wizard appears, click on Next.

Figure 4. Installation Wizard

8. If the Windows Security confirmation window appears, click on Install this driver software anyway.

Figure 5. Windows Security Confirmation
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Installing the Printer Driver

9. The Driver Package Installation will begin. When the Completing the Device Driver Installation Wizard appears, 
click Finish.

Figure 6. Finish Installation Wizard

INSTALLING THE PRINTER DRIVER

Connect the printer to the computer using the USB cable and turn the printer power ON. The printer will be recognized, and 
the driver installation will begin.

1. When the driver installation begins, the message Installing device driver software will appear above the task bar.

Figure 7. Driver Installation Message

2. Click on the driver installation message and the Driver Software Installation window will open. The driver 
installation status will be shown. Click Close.

Figure 8. Driver Software Installation
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Installing the Printer Driver

Note
The operating system may be configured to search for the driver software from Windows Update, 
so it may take more time to complete the installation. Click on Skip obtaining driver software 
from Windows Update to decrease the time it takes to complete the installation. (see below)

Figure 9. Skip Obtaining Driver Software from Windows Update

3. When the confirmation window appears, click Yes.

Figure 10. Confirmation Window

4. After the installation is complete, the message above the task bar will read, Your device is ready to use.

Figure 11. Driver Installation Complete Message
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Installing the Printer Driver

Note
If the DS printer driver installation was unsuccessful, the message Device driver software was 
not successfully installed will display. (see below) If the driver installation was unsuccessful, 
refer to the next section, Installing a Driver for an Unspecified Device and install the driver.

Figure 12. Driver Not Installed Message

5. Click on the Driver Installation Complete message and the Driver Software Installation window will open. Your 
device is ready to use will display. Click Close.

Figure 13. Driver Installation Software Complete

6. Select Start, then Control Panel. Click on View devices and printers in the Control Panel.

Figure 14. Control Panel
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Installing a Driver for an Unspecified Device

7. Confirm that your DS printer is shown in the Devices and Printers window. Installation is complete.

8. When installation of the printer driver is complete, reboot the computer. 

INSTALLING A DRIVER FOR AN UNSPECIFIED DEVICE

Before installing the driver package, connect the printer (with the power ON) to the computer, to create an Unspecified 
device in the Devices and Printers window. The printer driver can then be installed using the following instructions.

1. Install the driver package by following the instructions in the previous section, Installing the Driver Package. After 
the driver package has been installed, the driver for the Unspecified device may be automatically installed.

2. In the Devices and Printers window, under Unspecified, right-click on the Photo Printer and select Troubleshoot 
from the menu.

Figure 15. Unspecified Photo Printer
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Installing a Driver for an Unspecified Device

3. When the Install a driver for this device window appears, click on Apply this fix. It will automatically search for the 
driver and the installation will begin.

Figure 16. Apply This Fix

4. After the driver has been installed, the message Troubleshooting has completed will display. 
Click Close the troubleshooter.

Figure 17. Troubleshooting Complete
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Installing a Driver for an Unspecified Device

5. Confirm that your DS printer is displayed in the Devices and Printers window. The driver installation is complete.

Figure 18. Devices and Printers

6. When installation of the printer driver is complete, reboot the computer.
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Installing a Driver for an Unspecified Device
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2

DRIVER PROPERTIES

OPENING DRIVER PROPERTIES

7. From the Start Menu, click on Control Panel.

Figure 19. Control Panel

8. In the Control Panel, select Printer to open the printer window.

Figure 20. Control Panel
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Opening Driver Properties

9. Select the DS Printer you wish to configure (shown here as the DS40), right-click on the printer, and from the pull-
down menu select Properties to open the DS Properties window.

Figure 21. Selecting DS Printer

10. The Properties Window will open.

Figure 22. DS40 Properties Window
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Exploring the Print Setting Functions

EXPLORING THE PRINT SETTING FUNCTIONS

Using the properties window, you can use the Print Settings to change the Layout of your prints, change Advanced 
Options, change the Paper or Quality of the print, change the Paper Options, or Adjust the Color of the prints.

Layout Tab

Figure 23. Layout Tab

Using the Layout tab, you can change Print Orientation, Page Order, or how many pages per sheet will print.

Print Orientation

You can assign Print Orientation to be vertical or horizontal.

Figure 24. Print Orientation
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Layout Tab

Print Order

When printing multiple images within the application, you can change which will print first.

Figure 25. Print Order

Pages per Sheet

You can select a fraction to determine the print size.

Figure 26. Prints per Sheet
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Advanced Options in Layout

Advanced Options in Layout
By selecting the Advanced Settings tab in the Layout window, you can change Items in the Paper Output, Graphic and 
Document Options sections.

Figure 27. The Advanced Settings Button

Paper Output Settings

 Paper Size: designate paper size (for multiple layout options, see section Multiple Image Layout)

Note
Please match paper size to the media size in the printer. (4x6, 6x9, 8x12)

Copy Count: change number of times the image will be printed.

Graphic Settings

Print Quality: choose the DPI for your prints.

Image Color Management

ICM Intent: designates the rendering method when using ICM. Always have the ICC profile for the DS printer set 
to Picture. DO NOT use other settings.
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Advanced Options in Layout

Document Options

Advanced Printer Features: always have set to “enabled.” Do NOT 
use other settings

Printer Features

Border: syncs with the border option within the paper option. 
These should always match.

Overcoat Finish: The overcoat finish for the printed surface can be selected from two types.

Note
If you do not have the matte driver installed, you will only see the Glossy finish.

Attent ion
If you replace a printer with matte firmware installed with a printer with a lower firmware (glossy only), you MUST 
reboot the computer in order for the driver to detect the correct finishes available.

Print Re-try: determines if the print data stays in the buffer for reprinting after recovery from an error.
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Advanced Options in Layout

Depending on the error, you may have to power cycle the printer. When you power cycle the printer, the buffer 
will be cleared, even if you have set the print re-try to enable. Please reference the error table below.

Attent ion
If you replace a printer with matte firmware installed with a printer with a lower firmware (glossy only), you MUST 
reboot the computer in order for the driver to detect the correct buffer settings available.

2inch cut (for DS40 ONLY): If the proper paper size is used, the 2inch cut sets up whether the printer will cut into two or 
more sheets 2” in length.

Note
If you do not have the corresponding firmware, “disable” may be the only option available.
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Multiple Image Layout

Multiple Image Layout
Multiple layout is possible under the following conditions:

1. The DS40 is using 6x9 (A5W) or 6x8 media
The DS80 is using 8x12 or 8x10 media

2. The printer driver paper size is set to one of the sizes in the table below.

3. Multiple images are sent from the application.

Note
Because the multi-image layout occurs on a per job basis, this will only work when you send more 
than one image on a single job. If you want to print the same image multiple times, be sure to send 
the image data for each copy to be printed. The printer prints 2 or 3 images in one operation, and 
the paper is cut as it is fed out.

Multi-image layout patterns

The following combinations are possible for the multi-image layout patterns:
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Multiple Image Layout

Cautions for printing 2 DIFFERENT sized images on one sheet

When printing 2 different sized images on one sheet, 1 inch will be cut off the top and bottom of the 2nd image when the 
image is generated. When creating the original image, you should be aware of the following points (see examples below).

Example 1: When the layout is set for (8x6)_(8x4), the driver orders as thus:

1. It creates two 8x6 images

2. The driver then lays out the 2 different-size images from step 1 as one (8x10) image, 
and sends it to the printer.

Example 2: How to avoid having the image cut off (keeping the original image)

Before sending the images to the printer, the images are adjusted to the same size, so that the 1” that will be 
cut off from the second image (to make the 8x10 print) is blank, and the original image is retained. 
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Multiple Image Layout

Example of Application use (Windows Explorer)

1. Select 2 or more images, and click Print, then check “Fit Picture of Frame”, and click “options”

2. Click on “Printer Properties”, and from the “orientation” pull down menu, select Portrait.
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Multiple Image Layout

3. Click on “Advanced,” and Set the Paper Size to “(6x4)x2”. Then click “OK” on both Advanced and Printing 
Preferences options windows to return to the Print Picture screen.

4. Click on “print.”



22 DNPIMS America Corp.

Paper/Quality Tab

Paper/Quality Tab

Attent ion
Color settings should ALWAYS be set to Color. 
Do NOT select black and white printing.

Paper Options Tab

Border

Check the box if you want to add a border to your prints.

Note
Border setting syncs with the settings in 
Advanced Settings > Border

Sharpness

Processes for 11 separate sharpness levels (see image at right), where) means 
there is NO sharpness processing. Moving to (-) negative numbers will blur the 
image, and moving to (+) positive numbers will increase the sharpness.

Color Adjustment

(syncs with the ICM method in Advanced Settings)

None: disables the ICM and Color Adjustment tab, and color management will not be handled by the driver.

Handled by Driver: disables the ICM and enables Color Adjustment tab. 
You can adjust gamma, brightness, contrast and chroma.

ICM: enables the ICM from the host system, and enables color management from the driver.

ICM & Driver: ICM and color adjustment are enabled.

About

 displays the driver version



DNPIMS America Corp. 23

Color Adjustment Tab

Color Adjustment Tab
If you check Handled by Driver in the Paper Options Tab, you can now use this tab 
to adjust the Gamma, Brightness, Contrast, and Chroma of your images.

Use the following range chart to adjust your image:

DEFAULT VALUES FOR VARIOUS SETTINGS

Default values for each option (at the time of installation) are shown below. If the printer driver does not work correctly after 
changing these options, please return the options to the default settings.
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Color Management

COLOR MANAGEMENT

Color Management designates the color profile. Default at installation is [DS40_xxxx], where xxxx is a four-digit number 
that refers to the version.

Select the Color Management tab in the Printer Properties, and click on the Color Management button, then choose the 
printer DS40 from the device listed.

PRINT AREA

Depending on the paper size designated at the driver, the image and DPI will be as below:

*With the DS80 printer, the paper size (output size) can be designated as less than 8 inches, but the media used will be the 
DS80 8 inch width media.
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3

UPDATING THE DRIVER

In order to update the printer driver, follow the steps below.

Note
Updating the driver is the same for both the DS40 and DS80 printers. The following instructions 
are for the DS40, but if you are using a DS80, it will be the same (read DS40 as DS80).

DRIVER REMOVAL

5. Before removing the printer-driver, shut down all other applications. In the Devices and Printers window, double-
click the icon for the driver to be removed, and make sure there are no documents in the queue before you begin 
removal of the driver.

Figure 28. Devices and Printers Window
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Driver Removal

6. From the Devices and Printers window right-click on the DS printer.
Select Remove Device from the File Menu.
When prompted Are you sure you want to delete the printer ‘DS40’?, click Yes.

Figure 29. Remove Device

7. After the DS40 printer has been removed, select another printer (for example: Fax), and click on Print server 
properties in the menu bar. 

Figure 30. Print Server Properties in File Menu
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Driver Removal

8. When the Print Server Properties window opens, click on the Drivers tab. From the list of installed printers, find 
your DS printer, and click the Remove button.

Figure 31. Print Server Properties Window

9. When the Remove Driver and Package window appears, select Remove driver only and click on the OK button.

Figure 32. Remove Driver and Package Window

Note
Removal of the driver package takes place in the next section, Uninstalling the Driver Package.
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Uninstalling the Driver Package

10. When the Print Server Properties confirmation window opens, click the Yes button.

Figure 33. Print Server Properties confirmation window

11. Using the Print Server Properties window, confirm that your DS printer has been removed, and click the on the 
Close button.

Figure 34. Remove Driver Package window

UNINSTALLING THE DRIVER PACKAGE

1. Select Start, then Control Panel. Click on Uninstall a Program in the Control Panel.

Figure 35. Control Panel
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Installing the Printer Driver Upgrade

2. When the Uninstall or Change Name window appears, double-click on Windows Driver Package – Dai Nippon 
Printing DS40/DS80 (mm/dd/yyyy x.x.x.x).

Note
mm/dd/yyyy is the date. x.x.x.x is the version.

Figure 36. Uninstall or Change Name Window

3. When the Uninstall Driver Package window appears, click on Yes. The uninstall will be complete.

Figure 37. Uninstall Driver Package

4. After you are finished uninstalling the driver package, reboot the computer.

INSTALLING THE PRINTER DRIVER UPGRADE

After removing the printer-driver and driver package, install the new printer-driver. For installation steps, please refer to 
Chapter 1.

REBOOTING THE COMPUTER

After installation of the printer-driver is complete, be sure to reboot the computer.

Attent ion
Do NOT print immediately after installation. First reboot the computer.
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Rebooting the computer


